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Introduction 

 
The examples in this manual can be made in a full licensed as well as in a tryout or student version of 
SCIA Engineer. 
 

Here follows an overview of the required SCIA Engineer modules / editions, per subject: 
- Theoretical reinforcement design 
esacd.02 (2D members)  Concept edition 
 
- Practical reinforcement design 
esacdt.03 (2D members)  Concept edition 
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Plate design 

Model 

1_Input of geometry 

Project data: 2D environment = Plate XY 

 
  
The Reinforcement material (e.g. B500A) chosen in the Project data window, will define the steel 
quality used for the theoretical reinforcement design. 
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Properties of the slab and the line supports: 

 
 

 
 

2_Loads 

Load cases & Load groups 

Load Case Action type Load Group Relation EC1-Load type 

Self  weight Permanent LG1 / / 
Walls Permanent LG1 / / 

Service load Variable LG2 Standard Cat B: Offices 
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Load combinations 

Type EN-ULS (STR/GEO) Set B 
Type EN-SLS Quasi Permanent 

 

Result classes 

All ULS+SLS 

 
 

3_Finite element mesh 

Introduction 

2 types of finite elements are implemented in SCIA Engineer: 
- The Mindlin element including shear force deformation, which is the standard in SCIA Engineer. The 
Mindlin theory is valid for the calculation of both thin and thick plates. 
- The Kirchhoff element without shear force deformation, which can be used to calculate and design 
only thin plates. 
 
The element type used for the current calculation is defined in the Setup menu > Solver: 
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Mesh generation 

Via the Main menu > Calculation, mesh > Mesh generation, or ‘Project’ toolbar  
 

Graphical display of the mesh 

Set view parameters for all, via right mouse click in screen or Command line toolbar  
- Structure tab > Mesh > Draw mesh 
- Labels tab > Mesh > Display label 
 

Mesh refinement 

Via the Main menu > Calculation, mesh > Mesh setup, or Setup menu > Mesh 
Average size of 2D (mesh) elements is by default = 1m. 

 
 
‘Basic rule’ for the size of 2D mesh elements: take 1 to 2 times the thickness of the plates in the 
project. For this example, take a mesh size of 0,25 m. 
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4_Results for the linear calculation 

Specification of results 

After running the linear calculation, go to the Main menu > Results > Member 2D - Internal Forces. 
Specify the desired result in the Properties menu: 

 
 
-System 
     Local: according to the local axes of the individual mesh elements 
     LCS-Member 2D: according to the LCS of the 2D member 
     Attention when working with shell elements! 
-Location: 4 different ways to ask for the results, see Annex 2 
-Type forces: Basic, Principal or Design magnitudes, see Annex 1 

-Drawing setup: Click on the button . Here you can modify the display of 2D results (Isobands / 
Isolines / Numerical results / ...), modify the minimum and maximum settings, ... 
 
After making changes in the Properties menu, you always have to execute the ‘Refresh’ action. 
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Types of results 

Basic magnitudes 

Combination = ULS; Type forces = Basic magnitudes; Envelope = Minimum; Values = mx 

 
 

Design magnitudes 

Combination = ULS; Type forces = Design magnitudes; Envelope = Maximum; Values = mxD+ 

 
 
The available values are mxD, myD and mcD, where ‘D’ stands for design. The ‘+’ and ‘-‘ respectively 
stand for the values at the positive and negative side of the local z axis of the 2D member. 
So for instance the value mxD+ is the moment that will be used for the design of the upper 
reinforcement in the local x-direction of the 2D member. 
 
The calculation of design moments for plates and shells according to the EC2 algorithm follows the 
chart from CSN P ENV 1992-1-1, Annex 2, paragraph A2.8. 
The calculation of design forces for walls according to the EC2 algorithm follows the chart from CSN P 
ENV 1992-1-1, Annex 2, paragraph A2.9. 
An overview can be found in SCIA Engineer’s Help menu > Contents > Reference guide. 
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What happens, is that for the 3 characteristic (bending and torsion) moments an equivalent set of 3 
design moments is calculated: 

mx   mxD 

my         ≈  myD 

mxy   mcD 
 
It is clear that mxD and myD are the moments to be used for the reinforcement design in the respective 
direction. The quantity mcD is the design moment that has to be taken by the concrete. The Eurocode 
does not mention any check for this value, but it is however available in SCIA Engineer for the reason 
of completeness. 
 
Analogously, if membrane effects are present, for the 3 characteristic membrane forces an equivalent 
set of 3 design forces is calculated: 

nx   nxD 

ny         ≈  nyD 

nxy   ncD 
 
Here, the quantity ncD does have a clear meaning: it is the compression force that has to be taken by 
the concrete compression struts. Therefore, to make sure that concrete crushing will not occur, the 
value ncD should be checked to be ≤ fcd.  
 
Attention: These design magnitudes are not the ones used by SCIA Engineer for the reinforcement 
design in the Concrete menu. A much more refined transformation procedure is implemented there to 
calculate the design magnitudes from the basic magnitudes. 
 

Principal magnitudes 

Results menu > Member 2D – Stresses 
Combination = ULS; Type forces = Principal magnitudes; Envelope = Maximum; Values = sig1+ 
Drawing = Trajectories 

 
 
‘1’ and ‘2’ refer to the principal directions, calculated based on Mohr’s circle. 
The first direction is the direction of maximum tension (or minimum compression). The second direction 
is the direction of maximum compression ( or minimum tension). 
 
Keep in mind that the most economic reinforcement paths are the ones that follow the trajectories of 
the principal directions! 
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Comparison Mindlin ↔ Kirchhoff 

Shear force vx 

Combination = ULS; Type forces = Basic magnitudes; Envelope = Maximum; Values = vx 
 
Mindlin 

Section at lower edge 

   Mesh size = 0,25 m 

   Mesh size = 0,05 m 
 
Kirchhoff 

Section at lower edge 

   Mesh size = 0,25 m 

   Mesh size = 0,05 m 
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Torsion moment mxy 

Combination = ULS; Type forces = Basic magnitudes; Envelope = Maximum; Values = mxy 
 
Mindlin 

Section at lower edge 

   Mesh size = 0,25 m 

   Mesh size = 0,05 m 
 
Kirchhoff 

Section at lower edge 

   Mesh size = 0,25 m 

   Mesh size = 0,05 m 
 
 
Conclusion: Kirchhoff gives the expected shear force values, Mindlin gives the expected torsion 
moments. 
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Concrete setups 

1_General setups 

Setup 1: National Determined Parameters 

Main menu > Project data > National annex […] > EN 1992-1-1 […] 

 
 

Setup 2: Basic settings 

Concrete menu > Design defaults 
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Setup 3: Advanced settings 

Setup menu > Concrete solver  

 
 
All of the adjustments made in one of the three general setups are valid for the whole project, except 
for the members to which ‘Member data’ are added. 
 

2_ Member data 

It is possible to overwrite the data from the general setups per 2D member, namely by means of 
Member data; see Concrete menu > 2D member > Member data. 
On a plate with Member data appears a label, e.g. DSC1 (= Data Slab Concrete). This label can be 
selected at any time to view or to adapt the data via the Properties menu. Since Member data are 

additional data, it is possible to copy them to other plates, via ‘Geometry manipulations’ toolbar  or 
via a right mouse click. 
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ULS design 

1_Theoretical reinforcement design 

Internal forces 

Concrete menu > 2D member > Member design > Internal forces ULS 

Basic magnitudes 

The values shown here are exactly the same as in the Results menu; they are calculated by the FEM 
solver. 
The example is continued with the results based on the Mindlin theory. 
 

Design magnitudes 

The values shown here are different from those in the Results menu. 
- The design magnitudes in the Results menu are calculated by the FEM solver according to some 
simple formulas specified in EC-ENV. 
- The design magnitudes in the Concrete menu are calculated by the NEDIM solver, where a much 
finer transformation procedure is implemented, based on the theory of Baumann. 
These are the values that will be used for the SCIA Engineer reinforcement design. 
 
For more detailed information, reference is made to the Benchmark examples added at the end of this 
manual. 
 
Take a look at the available values: m1+, m1-, m2+, m2- (and mc+, mc-) 
“+” and “-“ stand for the design values at respectively the positive and the negative side of the local z-
axis of the 2D member. 
“1” and “2” stand for the reinforcement directions, which are by default respectively the local x- and y- 
direction of the 2D member. 
(mc+ and mc- are the design moments that would have to be taken by the concrete, but they have no 
real significance for the reinforcement design.) 
 
Combination = ULS; Type values = Design magnitudes; Value = m1+ 

 
 
Compare the result for this value m1+ (Concrete menu) with the result for the equivalent value mxD+ 
(Result menu) shown on p.10.  
Despite the different transformation procedures, the general image of the results will be similar for 
orthogonal reinforcement directions (acc. to the local x and y axes). The largest difference is caused by 
the ‘shear effect’ / ‘shift of the moment line’ that is only taken into account in the design magnitudes 
calculated by the NEDIM solver (values m1 and m2). 
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Shear effect / Moment shift 

The notion ‘shear effect’ is used for the additional tensile force in the longitudinal reinforcement, 
caused by shear. 
This additional tensile force is nothing else than the natural force complement to the stirrups force, both 
representing, together with the concrete strut force, the resistance of the reinforced concrete continuum 
to shear force impact. The thus required additional longitudinal reinforcement is no increment to 
bending reinforcement, but an autonomic longitudinal shear reinforcement, complementary to the 
(lateral) stirrups. In low-height cross-sections, the longitudinal shear reinforcement is usually 
constructively merged with the tension reinforcement (due to m/n).In high cross-sections it has to be 
dispersed along the cross-section height. 
 
In EN 1992, 2 approaches are described to take this additional tensile force into account in the 
reinforcement design: 
 
1) The ‘shear effect’ approach – EN §6.2.3(7) 
This approach is meant for members with shear reinforcement. 
The additional tensile force, ΔFtd, in the longitudinal reinforcement due to shear VEd is calculated from 

ΔFtd = 0,5 VEd (cotθ - cotα)       (EN formula 6.18) 

and (MEd/z) + ΔFtd  ≤  MEd,max/z, where MEd,max is the maximum moment along the beam. 
 
2) The classic ‘moment shift’ approach – EN §9.2.1.3(2) and §6.2.2(5) 
→ For members without shear reinforcement, ΔFtd may be estimated by shifting the moment curve (in 
the region cracked in flexure) a distance al = d in the unfavourable direction. 
→ For members with shear reinforcement, this ‘shift rule’ may also be used as an alternative to the 
‘shear effect’ approach, where al = z (cotθ - cotα) / 2.     (EN formula 9.2) 
 
In SCIA Engineer there are 3 options to control the ‘shear effect’ in the 2D reinforcement design. 
The choice can be made in the Setup menu > Concrete solver > ULS – Shear – 2D structures: 

 
 
a) Shear effect considered in SR2 
The value of ΔFtd is calculated directly (EN §6.2.3(7)), which is in fact the most accurate approach. 
‘SR2’ stands for shear region 2, which is defined by the DIN 1045 terminology as the region where 
shear reinforcement is required to resist vEd. 
This is the default setting in SCIA Engineer, which explains the design moments m1+ along the upper 
and lower edges of the plate (see image on previous page). Because of the high (singular) shear 
forces along the free edges, also a high value of ΔFtd is obtained, which is accounted for in the design 
moments. 
 
b) No shear effect considered 
The ‘moment shift’ approach (EN §9.2.1.3(2)) is applied. 
If this option is activated, the result for m1+ is as follows. 
 
Combination = ULS; Type values = Design magnitudes; Value = m1+ 
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c) Shear effect considered unconditionally 
The same as (a), but the value of ΔFtd is also calculated in the region SR1. 
‘SR1’ stands for the region where no shear reinforcement is required; the cross-section resists vEd by 
the bearing capacity of plain concrete. It is, however non-standard, an option, because some norms, 
like NEN 6720 §8.1.1, require the ‘shift’ of the moment line also in SR1. 
For design acc. to EN 1992, this is practically not an alternative. 
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Theoretically required reinforcement 

Concrete menu > 2D member > Member design > Member design ULS 
 

Longitudinal reinforcement 
Analogously to the design magnitudes, the available values here are: As1+, As1-, As2+, As2- 
 
Combination = ULS; Type values = Required areas; Reinforcement = Required reinf.; Value = As1+ 

 
This is the longitudinal reinforcement, calculated based on the design magnitude m1+. 
In the tension zones, a minimum reinforcement area is taken into account by default, according to EC-
EN §9.2.1.1(1).  
 

Shear force reinforcement 
Combination = ULS; Type values = Required areas; Reinforcement = Required reinf.; Value = Asw 
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Reinforcement directions & layers 

The convention for the reinforcement areas is obviously the same as for the design magnitudes: 
“+” and “-“ stand for the reinforcement areas at respectively the positive and the negative side of the 
local z-axis of the 2D member. 
“1” and “2” stand for the reinforcement directions, which are by default respectively the local x- and y- 
direction of the 2D member. 
 
The user is free to change the default direction angles and, moreover, add a 3rd reinforcement 
direction. This is only possible via Member data: 

 
Up to 10 reinforcement layers per side (top / bottom) can be created; to each layer one of the 3 
directions is assigned. 
 
Attention: Layers are always numbered from the outside to the centre of the 2D member! 
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Errors & warnings 

Concrete menu > 2D member > Member design > Member design ULS 
 
At the bottom of the Properties menu, go to Actions > Calculation Info: 

 
This gives an overview of all the warnings and errors present in the project. 
 
Warning = Information about the applied reinforcement. 
Error = Real (theoretical) design problem: the result value cannot be calculated. 
 

Most common errors 

- Error E8: Shear: concrete bearing capacity exceeded 
This error message is found at locations with high peak values for the shear stress. Most of the time 
these peak values are singularities, and do not occur in reality. You have roughly 2 options: you can 
just ignore the peaks or average them, for example by means of Averaging strips. 
 
- Error E6: Allowable concrete strut pressure exceeded 
This means in fact that the resistance of the virtual concrete strut is exhausted, so the concrete strut 
gets ‘crushed’. This is a way of failure that isn't considered in any other calculation software (according 
to the developer of our solver), but is a real issue. The virtual concrete strut symbolises the stiffening 
function of the concrete continuum. The pressure in the strut may not exceed 80% of the concrete 
strength fcd (this reduction coefficient can be adapted in the Concrete Setup), in order to provide for 
the effective diminuishing of the ‘plain’ concrete strength due to parallel cracks. Failure of the strut is 
generally caused by inefficient reinforcement geometry. 
The solution is to try a thicker cross-section or a higher concrete class, this is generally the easiest way 
to improve the bearing capacity of the concrete strut. Choosing another reinforcement geometry may 
be the optimum solution (“trajectory reinforcement”, following the principal directions), but is less 
practical. Purely augmenting the reinforcement amount is, however, inefficient. Also the use of 
Averaging strips won't help in most of the cases of E6 errors, because we are not dealing with a 
singularity here. 
 

Measure 1: Averaging strips 

Concrete menu > 2D member > Averaging strip 
Add averaging strips to the short sides of the opening, where the line supports are located. Also above 
the line supports over the total width of the slab, an averaging strip can be added. 
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As a basic rule, take the width of the averaging strips equal to the width of the support + 1 to 2 times 
the thickness of the slab. 
 
When asking results now, select the option ‘Averaging of peak’ in the Properties menu! 

 
 
When asking the values for the theoretical reinforcement again, the errors E8 don’t appear anymore: 
 

Longitudinal reinforcement 
Value = As1+ 

 
 

Shear force reinforcement 
Value = Asw 
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Measure 2: Increasing the concrete grade 

In the Properties menu of the slab, choose for a higher concrete grade: C25/30 instead of C20/25. 
 
After a new linear calculation, and when asking the values for the theoretical reinforcement again, the 
error E6 has also disappeared: 
 

Longitudinal reinforcement 
Value = As1+ 

 
 

Shear force reinforcement 
Value = Asw 
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Extra feature: User scale isolines 

Keep in mind that this feature is no basic reinforcement, it’s only an adaptation of the graphical display 
for the results: 
 

 
 

 
 

Longitudinal reinforcement 
Value = As1+ 
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Basic reinforcement 

This is a reinforcement amount added to the whole plate. In SCIA Engineer, the basic reinforcement is 
referred to as user reinforcement 
 
Defining (theoretical) basic reinforcement is only possible via Member data. 
Select the plate, choose the option ‘User reinforcement’, and input a Diameter and Basic distance for 
directions 1 and 2. 
If you select also the option ‘Different layers per side’, it is possible to define the upper and lower 
reinforcement independently from each other. 

 
 
To view the modifications, go to 2D member > Member design – Design ULS. For Combination = ULS 
ask Reinforcement = User / Additional / Total reinforcement, with Value = As1+ 

 
User reinforcement As1+ 
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Additional reinforcement As1+ 

 
 

Total reinforcement As1+ 

 
 
Take a look at the legend to see the difference in result values between additional and total 
reinforcement. 
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2_Practical reinforcement design 

Basic reinforcement 

It is logical to start with the definition of a practical reinforcement amount added to the whole plate. This 
can be done via the Concrete menu > 2D member > Reinforcement 2D. 
 
A question appears, if the theoretical basic reinforcement (defined via Member data) should be 
transferred to practical reinforcement. Choose ‘Yes’. 

 
 

 
 
Attention: From the moment practical reinforcement has been added to a member, the total amount of 
practical reinforcement is accounted for as the user reinforcement. This means that the theoretical 
basic reinforcement (defined via Member data) is overwritten! 
 

Additional reinforcement 

In a second step, additional reinforcement might be defined on specific location(s) on the plate. This 
can be done via the same option - Concrete menu > 2D member > Reinforcement 2D. 
 
The locations where additional reinforcement is required, can be asked for via the Concrete menu > 2D 
member > Member design – Design ULS. Since the present practical reinforcement is the User 
reinforcement, ask for Combination = ULS, Reinforcement = Additional reinforcement. 
 
This extra reinforcement is to be added separately at the upper and lower side, and in the different 
reinforcement directions. 
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ULS + SLS design 

In this design process, next to the ULS requirements, also the requirements for cracking (SLS) are met. 
  

1_Input data for crack control 

Maximum crack width 

The values of the maximum crack width (wmax) are national determined parameters, dependent on the 
chosen exposure class. Therefore, this value can be found in the setup for National Determined 
Parameters, via the Main menu > Project data > National annex […] > EN 1992-1-1 […]. 
 

 
 
The NEDIM solver will perform the crack control for 2D members. 
The approach differs from the crack control for 1D members, where a value of the crack width is 
calculated and then checked against the value of wmax. For 2D members, the crack width is 
automatically limited during an iteration process (to 0,3 or 0,4 mm - based on the chosen exposure 
class). 
 

Class ‘All ULS+SLS’ 

According to the Eurocode, the requirements for cracking have to be met under the quasi-permanent 
load combinations. 
The intention of the ULS + SLS design is to give the user a required reinforcement amount that meets 
the ULS and cracking requirements. Therefore a class ‘All ULS+SLS’ has to be created, where at least 
one ULS combination and at least one quasi-permanent SLS combination are included. The NEDIM 
solver will first calculate the theoretical required reinforcement based on the ULS combination(s), and 
store the results in its memory. For this reinforcement amount (As,ULS) is then a crack control 
performed, based on the SLS combination(s). In the finite elements where wcalc ≤ wmax, the value of 
As,ULS is sufficient (As,ULS > As,SLS). In the finite elements where wcalc > wmax, extra reinforcement is 
added during an iteration process, until wcalc ≤ wmax. 
 
The required reinforcement that results from the ULS + SLS design is thus the maximum of (As,ULS; 
As,SLS), and will be used in most cases as minimum value for the practical design. 
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2_Theoretical reinforcement design 

Concrete menu > 2D member > Member design > Member design ULS+SLS 
 

Longitudinal reinforcement 
Analogously to the Member design ULS, the available values here are: Ar1+, Ar1-, Ar2+, Ar2- 
The subscription ‘s’ is replaced here by ‘r’ to make clear that the requirements for cracking are 
accounted for in these values. 
 
Class = All ULS+SLS; Type values = Required areas; Reinforcement = Required reinf.; Value = Ar1+ 
Select the option ‘Averaging of peak’! 

 
 

Maximal bar diameters 
Class = All ULS+SLS; Type values = Maximal diameters; Value = fr1+ 
Select the option ‘Averaging of peak’! 
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Maximal bar distances 
Class = All ULS+SLS; Type values = Maximal distances; Value = sr1+ 
Select the option ‘Averaging of peak’! 

 
 
 

3_Practical reinforcement design 

The procedure is exactly the same as for only ULS design, therefore reference is made to the previous 
chapter ‘ULS design’. 
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Crack control 

1_Input data for crack control 

Maximum crack width 

For information about the values of the maximum crack width (wmax) taken into account by SCIA 
Engineer, reference is made to the previous chapter ‘ULS + SLS design’. 
 

Combination SLS 

According to the Eurocode, the requirements for cracking have to be met under the quasi-permanent 
load combinations. 
The intention of the Crack control is to check if these requirements are met for 2D members with a 
certain reinforcement amount. The theoretical or practical reinforcement design has already been done 
in advance, therefore no class ‘All ULS+SLS’ is needed. The check will be executed only for the SLS 
combination(s). 
 

Type of used reinforcement 

The reinforcement amount in a 2D member for which the Crack control will be executed, is referred to 
as As,tot or As,user. 
 
User reinforcement As,user 

= Basic reinforcement   (as defined via Member data) 
= Practical reinforcement (as defined via Reinforcement 2D – if practical reinf. is 

designed, then its amount overwrites any basic reinf.) 
Total reinforcement As,tot 

= Required theoretical reinforcement (if As,user = 0) 
 = As,user + As,additional  (if As,user ≠ 0) 
 

2_Results for required theoretical reinforcement 

Concrete menu > 2D member > Member check - Crack control 
 
If you are interested in the results of the Crack control for the required theoretical reinforcement 
amount, then no basic nor practical reinforcement may be present! In the Properties menu, the ‘Type of 
used reinforcement’ = ‘As,tot’. 
To be able to get any results for the Crack control, the required theoretical reinforcement has to be 
stored at first. So go to Member design ULS or Member design ULS+SLS, and refresh the results. 
For this example, the results for Member design ULS+SLS are stored, where the calculated required 
reinforcement meets the requirements for cracking. Therefore we expect to find crack widths with a 
maximum value of 0,3 mm (according to the chosen exposure class XC3). 
Attention: This is nevertheless only the case if the results for Member design ULS+SLS are stored 
without averaging of peaks! 
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Crack width w+ 
Combination = SLS; Type of used reinforcement = As,tot; Value = w+ 

 
 

Crack width w- 
Combination = SLS; Type of used reinforcement = As,tot; Value = w- 

 
 

Unity check 
Combination = SLS; Type of used reinforcement = As,tot; Value = Check value 
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A green value stands for a Unity check ≤ 1 (wcalc ≤ wmax), while a red value means that wmax is 
exceeded. 

3_Results for basic reinforcement 

Concrete menu > 2D member > Member check - Crack control 
 
If you are interested in the results of the Crack control for the basic reinforcement amount defined via 
Member data, then no practical reinforcement may be present! In the Properties menu, the ‘Type of 
used reinforcement’ = ‘As,user’. 
The necessary additional reinforcement is not taken into account here, so it is probable that we will find 
crack widths larger than 0,3 mm. 
 

Crack width w+ 
Combination = SLS; Type of used reinforcement = As,user; Value = w+ 

 
 

Crack width w- 
Combination = SLS; Type of used reinforcement = As,user; Value = w- 
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Unity check 
Combination = SLS; Type of used reinforcement = As,user; Value = Check value 

 
A green value stands for a Unity check ≤ 1 (wcalc ≤ wmax), while a red value means that wmax is 
exceeded. 
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Annexes 

Annex 1: Conventions for the results on 2D members 

1_ Basic magnitudes = Characteristic values 

Bending (plates, shells) 

*Bending moments mx, my 
 

 
 
 
*Torsion moment mxy 
 

 
 
 
*Shear forces qx, qy (=vx, vy) 
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Membrane effects (walls, shells) 

*Membrane forces nx, ny 

 
 
 
*Shear forces qxy (=nxy) 
 

 
 

 

 

 

2_Principal magnitudes 

The principal magnitudes give the results according to the axes of the directions of the largest stresses  
(principal directions). These directions are defined with the help of the circle of Mohr. 

 

 

 

3_Design magnitudes 

To derive the design magnitudes from the basic magnitudes, formulas from the Eurocode EC-ENV are 
used. 
See also the Help menu > Contents > Reference guide, for these formulas. 
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Annex 2: Results in Mesh elements and Mesh nodes → 4 Locations 

 
During a calculation in SCIA Engineer, the node deformations and the reactions are calculated exactly 
(by means of the displacement method). The stresses and internal forces are derived from these 
magnitudes by means of the assumed basic functions, and are therefore in the Finite Elements Method 
always less accurate.  
 
The Finite Elements Mesh in SCIA Engineer exists of linear 3- and/or 4-angular elements. Per mesh 
element 3 or 4 results are calculated, one in each node. When asking the results on 2D members, the 
option ‘Location’ in the Properties window gives the possibility to display these results in 4 ways. 
 

1_ In nodes, no average 

All of the values of the results are taken into account, there is no averaging. In each node are therefore 
the 4 values of the adjacent mesh elements shown. If these 4 results differ a lot from each other, it is 
an indication that the chosen mesh size is too large. 
This display of results therefore gives a good idea of the discretisation error in the calculation model.  
 

   
 

2_ In centres 

Per finite element, the mean value of the results in the nodes of that element is calculated. Since there 
is only 1 result per element, the display of isobands becomes a mosaic. The course over a section is a 
curve with a constant step per mesh element.  
 

   
 

3_ In nodes, average 

The values of the results of adjacent finite elements are averaged in the common node. Because of 
this, the graphical display is a smooth course of isobands. 
 
In certain cases, it is not permissible to average the values of the results in the common node: 
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- At the transition between 2D members (plates, walls, shells) with different local axes. 
- If a result is really discontinuous, like the shear force at the place of a line support in a plate. The 
peaks will disappear completely by the averaging of positive and negative shear forces. 
 

   
 

4_ In nodes, average on macro 

The values of the results are averaged per node only over mesh elements which belong to the same 
2D member ánd which have the same directions of their local axes. This resolves the problems 
mentioned at the option ‘In nodes, average’.  
 

   
 
 

Accuracy of the results 

If the results according to the 4 locations differ a lot, then the results are inaccurate and this means the 
finite element mesh has to be refined. A basic rule for a good size of the 2D mesh elements, is to take 
1 to 2 times the thickness of the plates in the project. 
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Annex 3: Local Coordinate system for 2D members 

 
The results for a Finite Element analysis are computed according to the Local Coordinate System 
(LCS) of each mesh element. As a consequence, these results depend on the way the local axes for 
mesh elements are defined. A wrong definition of local axes can lead to very misleading results.  
 
Let’s consider the example below. A continuous plate is modeled as two elements D1 and D2: 
 

 
  
In order to display the mesh local axes, you need first to generate the mesh. You can use the button 

‘Mesh generation’  or Main menu > Calculation, Mesh > Mesh generation 
 
Afterwards, the mesh and local axes can be displayed from ‘Set View parameters for all’: right click of 
the mouse on the screen 
 

 
 
 
It is clear from the orientation of the axes that the continuity of the moments mx and my cannot be 
satisfied.  The moment mx on D1 corresponds in this case to the moment my in D2. 
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The moment mx on a section of the plate gives the Moment diagram1. After correction of the local axes 
orientation, Moment diagram2 is obtained. 

 
 
 
 
 
 
 
 
 
  
 

 
Moment diagram 1      Moment diagram 2 

 
 
By default, the program computes the local axes automatically. The user can adapt the direction of the 
axes in several ways using the Properties menu: 
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1_ Perpendicular to vector 

 
The local axis x(y) is perpendicular to a vector that is defined with its coordinates V(x1 y1 z1). 
 

 
 
 

The coordinates of the vector can be introduced in the properties window. You can also use the  
button next to x1 and define the vector graphically with a start point and end point. 
 
 

2_ Tilt of vector normal to line 

 
This method is similar to the one above. Instead of introducing a vector, a line is defined between two points. 
(x1 y1 z1) are the coordinates of the first point and (x2 y2 z2) are the coordinates of the second point. The 
x(y) axis is perpendicular to the introduce line and points towards it. 
 

 
 
 

The coordinates of the points that define the line can be introduced in the properties window. You can also 

click on the  button next to x1 and x2 and define these points graphically. 
 
 

3_ Congruent with line 

 
x(y) is oriented from the center of the element towards the intersection between the mesh element and 
the defined line : 

V 

Line by two points 
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4_ Smallest angle with vector 

 
x(y) is oriented such that it makes the smallest angle with the defined vector V(x1 y1 z1).  
 

 
 

 

5_ Tilt of vector defined by point 

x(y) is oriented towards a defined point (x1 y1 z1). This is suitable in case of a circular plates for 
example and allows the user to calculate radial reinforcement. 

Line by two points 

V 
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Remark: All the methods above are about how to adapt the x and y axes. The local z axis is defined 
automatically by the program but its orientation can be changed by ticking the box ‘Swap orientation’ in the 
Properties menu  
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2D Reinforcement Concrete Design of Walls acc. to EN 1992-1-1:2004 

Benchmark Example on SCIA Engineer NEDIM Performance (v6) 

Dipl.- Ing. Eduard Hobst Ph.D., Development Partner (Concrete) SCIA 

A. Fundamental Considerations 

Introductory note 

This benchmark example presents and explains the basic features of the 2D reinforcement concrete 

design module NEDIM of the program system SCIA Engineer 2013.1. The related Code/Norm on 

reinforced concrete is the EN 1992-1-1:2004. The analysis model is Wall, i.e. plane structure subject to 

inner membrane forces only.  

WALL design model 

Wall is the most simple of 4 design models dealt with by NEDIM (Wall, Plate, Shell, One-Layer). 

Since it is restricted to plain shape and subject to membrane forces, represented by the inner forces 

vector {nx, ny, nxy}, only (no bending), the concrete cover has impact on the Crack Proof only. Because 

of the transversal symmetry, there is no difference between the reinforcement on either face +Zp /–Zp. 

Thus, in Walls NEDIM calculates the total reinforcement (in each reinforcement direction). However, 

the very distinguishing feat of NEDIM, the processing of general 2/3 direction reinforcement nets is 

active also in the Wall design model. Thus, not only the standard orthogonal reinforcement net but 

arbitrary skew-angle and three-directional nets are available options. 

Special note on compression reinforcement 

Since concrete, according to all Norms, does not resist tension stresses (in strength calculations) the 

main task of reinforcement is to take on tension stresses appearing in a reinforcement concrete cross-

section. However, if heavy compression forces act upon a 2D structure, compression reinforcement 

may be required to support plain concrete. Typically for 2D structures, no statically required 

compression reinforcement but minimum compression one is needed according to most Norm 

stipulations. As a fact, none of the known (published) 2D design theories, including the Baumann’s 

theory [1], which was used as the theoretical base of the NEDIM design algorithm, do give an 

instruction how to design the compression reinforcement. Thus, its design is left to the program user’s 

subsequent hand calculation. The 2D situation is unlike the 1D design, where there is no problem to 

consider both tension and compression normal forces for reinforcement design. 

The NEDIM algorithm has been equipped with very special procedure, enabling the calculation of 

compression reinforcement in all stress situations as a generalization of the Baumann’s algorithm [1]. 

In elliptic pressure states (nII < nI < 0), there is a consistent solution available, which yields 

compression design forces to both/ all 3 reinforcement directions, leading directly to either statically 

required or minimum compression reinforcement.  

The hyperbolic pressure state (nI > 0, nII < 0) appears as a real challenge, also to the 2D design 

algorithm. NEDIM offers here a special solution, too, described in some detail in [1] (“Design of 

Walls”, Fig.4). The elementary idea is based upon the principle of redistribution: (1) the resistance to 

compression develops in the concrete continuum in the direction of the 2nd principal force nII < 0, no 

matter if there is laid reinforcement (exactly) in this direction or not; this fact “explains” the failing of 

all classical 2D design theories, which have to cope with arbitrary reinforcement geometry; (2) the 

NEDIM algorithm focuses to the Ultimate Load State (ULS) as the stress situation where the cross-

section may fail due to exhaustion of the resistance of plain concrete to compression. In such a case, 

another stress distribution takes place in the design point, engaging the existing reinforcement to 

participate in resisting the pressure force; (3) for this, NEDIM carries out a special inner forces 

transformation, which may exceed the elementary energetic level described by the generalized inva-

riant relation (5) in [1]; however, it represents a virtually possible state of stress. If there is found 

acceptable security for this state of stress, the structure is considered to be designable with the 

compression and tension reinforcement corresponding to this state of exploitation. 

In this Paper, paragraph C.4 presents numerical processing of a hyperbolic stress case with a consistent 

solution, i.e. meeting exactly the invariant relation (5) in [1]. 
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References 

The numerical calculations presented in this Paper have been based upon the SCIA Engineer projects 

Wall_Benchmark_EN(0), Wall_Benchmark_EN(1) and Wall_Benchmark_EN(2), which are integral 

parts of this benchmark document [0]. The fundamental theoretical information on 2D design is 

presented by the SCIA Theoretical Background manual [1] (with advanced references there in). 

B. Wall Example – Model Definition and FEM Results 

A 2D cantilever member subject to considerable horizontal line load –500 [kN/m] and an additional 

vertical tip force –100 [kN/m] was chosen to demonstrate the feats of the 2D design algorithm NEDIM 

under SCIA Engineer: 

 

Fig.1  SEN model of Wall – Geometry and FE mesh 

 

Fig.2  Results of FEM analysis: Inner forces nx – Direct values in element nodes (LC1) 
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Fig.3  Results of FEM analysis: Inner forces ny – Direct values in element nodes (LC1) 

 

Fig.4  Results of FEM analysis: Inner forces nxy – Direct values in element nodes (LC1) 

C. ULS Design – Statically required reinforcement  

In this Chapter, pure statically required reinforcement is dealt with by the project 

Wall_Benchmark_EN(0). To disable the determination of the minimum required reinforcement, 

which may superpose the statically required values, its specification has to be suppressed on input (see 

Chapter D, Fig.10, showing the SCIA Engineer First default Concrete Setup dialogue window for non-

zero minimum reinforcement). One consequence of suppressing the calculation of minimum 

compression reinforcement is vanishing of compression reinforcement in all design points where the 

bearing capacity of plain concrete is sufficient to resist compression stress. 

The NEDIM design results will be scrutinized in detail in three element nodes, as marked in Fig. 5 and 

6, using the special numerical protocol of the NEDIM Test Strategy: C.1 Elliptic tension design case; 

C.2 Elliptic pressure design case; C.3 Hyperbolic stress state design case. 

 

Fig.5  Design results: stat. required horizontal reinforcement as1 [mm²/m] – direct values in 

nodes 
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Fig.6  Design results: stat. required vertical reinforcement as2 [mm²/m] – direct values in nodes 

C.1  Design Case 1: Statically Required Reinforcement – Elliptic Tension 

As seen from Fig.2–4, in element 6, inner node 3 (mesh node 13), both basic membrane forces are 

positive: nx > ny > 0, i.e. tension. Thus, an elliptic tension state is expected. 

Table 1. Inner forces [kN/m] (Basic/ Principal/ Design) in element 6, node 13 (Test Strategy line 1#) 

nx ny nxy nI nII αI,II n1d n2d ncd 

174

.5 

71.

9 

-

20.

5 

178

.4 

68.

0 

-

10.

9° 

195

.0 

92.

4 

-

41.

0 

 

Fig.7  Graphic representation of Table 1 (Case 1 of inner forces transformation) 

The generalized invariant relation (5) in [1] is satisfied: 

n1d + n2d + ncd = 195.0 + 92.4 – 41.0 = 256.4    ~   nI + nII = 178.4 + 68.0 = 256.4   [kN/m] 

This is a standard transformation case. The design forces {n1d, n2d, ncd} may be, in analogy to 

mathematic terminology, considered as separated result variables of the 2D design problem, which 

thus disintegrates into three individual pseudo 1D design cases. The required reinforcement amount is 

calculated as in two mutually independent 1D members: 

asi,req = nid / fyd (1) 

as1,req = n1d / fyd = 0.1950 / (600 / 1.15) = 3.7410–4 [m²/m] = 374 [mm²/m] (agreement with Fig.5) 

as2,req = n2d / fyd = 0.0924 / (600 / 1.15) = 1.7710–4 [m²/m] = 177 [mm²/m] (agreement with Fig.6) 

The virtual concrete strut, which function may be formulated as “stiffening of the reinforcement net 

against distortion in its plane” is to be checked as plain concrete section with reduced concrete strength 

[1] (see Fig.11). With the 1st default value of the reduction factor rfac = 0.80 (i.e. only 80% of full design 
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strength of concrete, weakened by parallel cracks, may be applied), the resistance check of the virtual 

strut follows the formula: 

–ncd ≤ rfac × fcd × H (2) 

with H – full cross-section height (representing the “unit” area of H × 1 [m]). From (2) it follows: 

41.010–3 = 0.041 << 0.80 × 12/1.5 × 0.10 = 0.640 [MN/m] 

The check reveals satisfactory bearing capacity reserve of the stiffening concrete. 

C.2  Design Case 2: Statically Required Reinforcement – Elliptic Pressure 

As seen from Fig.2–4, in element 2, inner node 1 (mesh node 11), both basic membrane normal forces 

are negative: nx < 0 and ny < 0, i.e. compression. An elliptic compression state is expected. Table 2 

shows that it is true also in the transformed state: n1d < 0; n2d < 0. 

Table 2. Inner forces [kN/m] (Basic/ Principal/ Design) in element 2, node 11 (Test Strategy line 2#) 

nx ny nxy nI nII αI,II n1d n2d ncd 

-

101

9.7 

-

31.

4 

-6.2 

-

31.

3 

-

101

9.7 

90.

4° 

-

101

3.5 

-

25.

2 

-

12.

4 

 

Fig.8  Graphic representation of Table 2 (Case 2 of inner forces transformation) 

The generalized invariant relation (5) [1] is satisfied ("numerical" precision): 

n1d + n2d + ncd = –1013.5 – 25.2 – 12.4 = 1051.1    ~   nI + nII = –31.3 – 1019.7 = 1051.0  [kN/m] 

This is a special NEDIM transformation case. The required reinforcement amount is calculated as in 

two mutually independent 1D members: 

asi,req = (–nid – H  fcd) / f 'ycd    with    f 'ycd = min ( fycd , Es εc1)  (3) 

In (3) fycd is steel strength in compression (1st input default: fycd = fyd); Es – Young’s modulus; εc1 – 

concrete yield point (bilinear stress-strain concrete diagram specified, εc1 = 0.175 %). 

Hint: the adapted compression steel strength f 'ycd respects the fact that concrete under centric pressure 

should not be allowed for higher than yield strain; thus, higher class reinforcement steel does usually 

not attain its yield point, i.e. ) fycd ≤ Es εc1 in most cases. From (3) it follows: 

f 'ycd = min (600.0 / 1.15, 200000.0 × 0.00175) = 350.0 [MPa] 

as1,req = (1.0135 – 0.10 × 12.0/1.5) / 350.0 = 6.1010–4 [m²/m] = 610 [mm²/m] (agreement with Fig.5) 

as2,req = (0.0025 – 0.10 × 12.0/1.5) / 350.0 < 0    →   as2,req = 0 (agreement with Fig.6) 

Obviously, the virtual concrete strut possesses sufficient resistance. 

C.3  Design Case 3: Statically Required Reinforcement – Hyperbolic Stress 
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As seen from Fig.2–4, in element 5, inner node 1 (mesh node 9), both basic membrane normal forces 

are negative: nx < ny < 0, i.e. compression. An elliptic compression state is thus expected like in Case 2. 

However, the “mixed” membrane component nxy, which generally imposes a tension effect upon both 

reinforcement directions x, y, reverts the elliptic pressure state of the homogeneous continuum to a 

virtual hyperbolic stress state, as Table 3 shows. 

Table 3. Inner forces [kN/m] (Basic/ Principal/ Design) in element 5, node 9 (Test Strategy line 3#) 

nx ny nxy nI nII αI,II n1d n2d ncd 

-

542

.7 

-

14.

6 

-

48.

3 

-

10.

2 

-

547

.1 

95.

2° 

-

494

.4 

+33

.8 

-

96.

6 

 

Fig.9  Graphic representation of Table 3 (Case 3 of inner forces transformation) 

The generalized invariant relation (5) [1] is satisfied ("numerical" precision): 

n1d + n2d + ncd = –494.4 + 33.8v – 96.6 = 557.2    ~   nI + nII = –10.2 – 547.1 = 557.3   [kN/m] 

This is a very special NEDIM transformation case. Baumann [1] and all other transformation theories 

would yield the 2nd principal force nII = –547.1 as the design result, assigning it to the plain concrete as 

virtual strut force; no reinforcement would be designed. Effectively, plane concrete design would have 

taken place. 

The required reinforcement amount is calculated once for compression, once for tension, i.e. according 

to the formulae (3) and (1), respectively: 

as1,req = (0.4944 – 0.10 × 12.0/1.5) / 350.0 < 0     →   as1,req = 0 (agreement with Fig.5) 

as2,req = 0.0338 / (600 / 1.15) = 6.4810–4 [m²/m] = 65 [mm²/m] (agreement with Fig.6) 

The tension force n2d = +33.8v has virtual character (trailing symbol “v”).  Under SLS, the reinforced 

concrete continuum would act as plain concrete without participation of the reinforcement, whereas in 

ULS, a redistribution of inner forces could take place, evoking the tension in steel as presented above.  

As a fact, this statement holds, in cases with required compression reinforcement.  Obviously, in cases 

of minor exploitation, like this one, no redistribution would take place.  However, this special design 

solution makes it generally possible, to assign minimum compression reinforcement according to the 

Code stipulations – see Table 4. 

Hint: the virtual reinforcement amount (here as2,req) is designed, consequently, as tension 

reinforcement !!! 

D. Required Minimum Reinforcement 

Numerical results and screen copies of this Chapter were obtained by the project 

Wall_Benchmark_EN(1). 

In this Chapter, the effect of activated minimum reinforcement specification according to NEDIM 1st 

default input, as shown in Fig.10, is dealt with. As a fact, the user may modify the settings, but 
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accepting them, legal solution according to the Norm is obtained. The position of the virtual strut input 

in the Setup dialogue is shown in Fig.11. 

 

Fig.10  Concrete Setup > Detailing provisions > 2D structures – Minimum reinforcement 
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Fig.11  Concrete Setup > Calculation > 2D structures > Special design control – Virtual strut 

reduction 

The minimum tension reinforcement is stipulated by §9.2.1.1, formula (9.1N). In NEDIM terms: 

ast,min = max (0.26 fctm / fyk , 0.0013) × d     [m²/m] (4) 

With fctm = 1.6, fyk = 600 [MPa] and d = H – a1 = 0.100 – (0.030+0.10/2) = 0.065 [m] (a1 is the effective 

static height: a1 = c1 +  /2) of the outer reinforcement layer, for consistency with a corresponding 

bending case), the 2nd term in (4) is decisive, thus ast,min = 0.0013 d = 0.00013x0.065 = 0.0000845 [m²/m]. 

However, in Walls the total reinforcement is presented; thus, the resulting reinforcement is double as 

much: 

ast,min =  2 × 0.0013 d = 0.000169 [m²/m] = 169 [mm²/m], 

as displayed in Fig.13 in all nodes where ast,req < ast,min. 

 

 

Fig.12  Horizontal reinforcement as1, req+min [mm²/m] – Direct values in nodes 
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Fig.13  Vertical reinforcement as2,req+min [mm²/m] – Direct values in nodes 

The minimum compression reinforcement is governed by §9.6.2. In 2D structures it is simply specified 

as 0.2% of gross cross-section. The corresponding formula in NEDIM is asc,min = 0,002 H [m²/m]. 

Hence, in Fig.12 and Fig.13 the value of 

asc,min = 200 [mm²/m], 

prevails since there is low intensity normal force in most element nodes active. Only in element nodes 

at the lower edge, the statically required values of compression reinforcement exceed the minimum 

values (compare with Fig.5). 

E. Minimum Structural Reinforcement of Deep Beams 

Numerical results and screen copies of this Chapter were obtained by the project 

Wall_Benchmark_EN(2). 

EN 1992-1-1:2004, §9.7 deals with (minimum) structural reinforcement of so called Deep Beams. 

NEDIM controls this assignment by the pertinent input option in Concrete Setup > Detailing provisions 

> 2D structures, as shown in Fig.10; the checkbox has then to be activated (yes). The Deep Beam 

control option is set inactive in the project variants (0) and (1). On the other side, the specification of 

minimum reinforcement (tension and compression) from the variant (1) is maintained in variant (2). 

Thus, the reinforcement results obtained here constitute the absolute "constructive reinforcement 

envelope”. The following result displays of as1,sup and as2,sup in Fig.14 and Fig.15 the original values of 

as,req which have not been exceeded by both minimum / constructive reinforcement controls are marked 

by encircling.  

The minimum constructive reinforcement of Deep Beams according to §9.7(1) takes on in NEDIM 

terms the following shape: 

as,DBmin = max (0.001H , 0.00015)     [m²/m] (5) 

Since in Walls the total reinforcement is showed, the resulting constructive reinforcement is double as 

much.  

Numerically: 

as,DBmin = 2 × max (0.001 × 0.10, 0.00015) =  0.0003 [m²/m] = 300 [mm²/m], 

This is the value displayed in Fig.14 and Fig.15 in most nodes where as,req+min < as,DBmin. 

Following Table 4 compares the reinforcement designed at the three discussed design stages. Green 

shadowing marks the stage Required when it is superior to Minimum and DB reinforcement. Blue and 

Red mark the stages Minimum and DB exceeding the preceding stage(s). Pressure reinforcement values 

are marked with trailing “*”. 
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Fig.14  Result envelope: horizontal reinforcement as1,sup [mm²/m] – Direct values in nodes 

 

Fig.15  Result envelope: vertical reinforcement as2,sup [mm²/m] – Direct values in nodes 

Table 4. Comparison of the reinforcement stages in investigated design points 6/13, 2/11 and 5/9 

Elem/Node 

Horizontal reinforcement (1)   

[mm²/m] 

Vertical reinforcement (2)   

[mm²/m] 

as1,req as1,req+min as1,sup as2,req as2,req+min as2,sup 

6/13 374 374 374 177 177 300 

2/11 610* 610* 610* 0 200* 300 

5/9 0 200* 300 65 169 300 
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2D Reinforcement Concrete Design of Plates acc. to EN 1992-1-1:2004 

Benchmark Example on SCIA Engineer NEDIM Performance (v6) 

Dipl.- Ing. Eduard Hobst Ph.D., Development Partner (Concrete) SCIA 

A. Fundamental Considerations 

Introductory note 

This benchmark example presents and explains the basic features of the 2D reinforcement concrete design 

module NEDIM of the program system SCIA Engineer (SEN).  The related Code/Norm on reinforced 

concrete is the Novella of EC2 – EN 1992-1-1:2004.  The structural/design model is PLATE, i.e. plane 

structure subject to pure bending.  

PLATE design model 

Plate is one of 4 design models supported by SEN/NEDIM (Wall, Plate, Shell, One-Layer).  It is restricted to 

pure bending, represented by the generalised force vector {mx, my, mxy, vx, vy} (membrane forces being absent 

by definition).  The very distinguishing feat of NEDIM – the processing of general 2/3 direction reinfor-

cement nets – is active also in the Plate model.  Thus, not only the standard orthogonal reinforcement net but 

arbitrary skew-angle and three-directional nets are possible options of the Plate design model of NEDIM.  

The position of each of 2/3 specifiable reinforcement courses at either face +Zp /–Zp of the cross-section is of 

fundamental meaning for the design, i.e. the concrete cover has not only impact on the Crack Proof. 

Special note on compression reinforcement 

Since structural concrete, according to all known Norms, does not resist tension stresses (in strength calcula-

tions) the main task of reinforcement is to resist tension stresses appearing in the tension zone of a reinforce-

ment concrete cross-section under bending.  However, if pronounced bending moments act upon a plate, 

compression reinforcement may be statically required to strengthen the concrete compression zone.  On the 

other part, no minimum compression reinforcement is required with pure bending by any of the known 

Norms!  NEDIM imposes a restriction to the design of compression reinforcement: the reinforcement 

directions (and their number, i.e. 2 or 3) at the faces +Zp /–Zp must be pair-wise congruent; however, not 

necessarily in the same specification order.  The position of each reinforcement course within the cross-

section is checked in order to establish its state of strain: courses lying deeply in the cross-section might not 

have reached the yield strain; the required compression reinforcement is then augmented appropriately. 

The hyperbolic bending (mI  >  0, mII  < 0) in plates does not constitute such a challenge to the 2D design algo-

rithm as in other models, which involve the membrane forces.  This is, simply speaking, due to the fact that 

no minimum compression reinforcement is required in plates.  Thus, it is in every way a standard solution, 

when in plates under the elliptic stress state (mI ≥ mII > 0) one face is designed without defined reinforcement.  

However, there are also in plates distinguishing theoretical and algorithmic features of the hyperbolic state of 

stress, which have been dealt with great thoroughness [1]. 

References 

The numerical calculations presented in this Paper have been based upon the SCIA Engineer projects 

Plate_Benchmark_EN(0), Plate_Benchmark_EN(1) and Plate_Benchmark_EN(2), which are integral parts of 

this benchmark document [0]. The fundamental theoretical information on 2D design is presented by the 

SCIA Theoretical Background manual [1]; in [1] advanced references may be found and examined. 

B. Plate Example – Model Definition and FEM Results 

A quadratic plate supported along all 4 edges, subject to a single Load Case consisting of plane load g = –3.5 

and p = –10.0 kN/m² and reinforced by congruent orthogonal nets 0°/90° at both faces (in this basic variant) 

has been defined to demonstrate the feats and design results of the 2D design algorithm NEDIM under SCIA 

Engineer.  Since the system is double-symmetric, only the “upper/left” quarter of plate’s model will be 

processed here by introducing the appropriate symmetry boundary conditions on the central symmetry axes 

(Fig.1).   
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Fig.1  SEN model of Plate – Geometry, FE mesh, Loads 

 

Fig.2  Results of FEM analysis: Inner moments my,max – Direct values in element nodes (ULS) 



Reinforced concrete (EN 1992) – 2D members 

58 

 

Fig.3  Results of FEM analysis: Inner moments mxy,max – Direct values in element nodes (ULS) 

 

Fig.4  Results of FEM analysis: Inner shear forces vx – Direct values in element nodes (ULS) 
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Concluding notes on inner forces 

(1) Due to system symmetry, the inner bending moments mx and my are mutually exchangeable when rotated 

by 90° in the plate plane. However, due to “numerical pollution” of the FEM approximation, mx and my 

are not exactly equal at central node 2, since they belong to the inner element node.  However, in the 

output mode “mean values in mesh nodes” the symmetry is maintained, since here all adjacent inner 

nodes contribute.  

(2) The statement of (1) is true also for the inner shear forces vx and vy. However, since shear force is an 

“anti-symmetrical” quantity, the sign can change. 

(3) A comparison of Fig.2 and 3 confirms the well known fact that the intensity of bending in the centre and 

in the corner of a (simply supported) quadratic plate is of about the same quantity.  There may be found 

other ratios when looking for tabled values in literature, but the differences are due to different plate 

solutions applied.  

(4) The shear force vx in Fig.4 is not the Kirchoff’s combined “shear reaction” (vn + ∂mxy/∂t); thus, vx → 0 in 

the corner(s). By fixing the radial rotation of the cross-section perpendiculars, as it is obvious from the 

boundary conditions representation in Fig.1, the torsion moment singular effects upon the function of the 

tangential shear force vt along the edges (vx – along the edges y = const; vy – along x = const), have been 

eliminated from the FEM solution.  Thus, neither the well-known Kirchhoff’s singular corner force R is 

not explicitly present in the model.  Refer to [1] for detailed description of this phenomenon, having 

already caused so many irritations on the hotline. 

C. ULS Design – Statically required reinforcement  

In this Chapter, pure stat. required reinforcement is dealt with by the variant project 

Plate_Benchmark_EN(0). To disable the determination of the minimum required reinforcement, which 

might superpose the statically required values, its specification is suppressed on input for purpose of this 

Chapter.  As shown in Fig.5, the control options “Minimum tension reinforcement” are unchecked for both 

faces.  The options “Minimum transverse reinforcement” and “Maximum degree of reinforcement” are 

important control values defaulted to the Norm stipulations.  The non-standard option “Maximum percentage 

in pressure bending zone”, which limits the amount of compression reinforcement (see Chapter A), relates 

the resisting force in the compression reinforcement to the concrete force activated in the compression 

bending zone of concrete cross-section.  The 1st default value of 50% is borrowed from SIA 162, §3.24.16; 

EN 1992-1-1:2004 does not stipulate this kind of control!  See also the alternative control as described in 

Chapter D, Fig.12.  

 

Fig.5  Input dialogue window – max/min tension reinforcement set inactive 

 

The NEDIM design results will be scrutinized in detail in three element nodes, as marked in Fig.6 and 7, 

using the special numerical protocol of the NEDIM Test Strategy:  C.1 Elliptic stress design Case 1; C.2 

Hyperbolic stress state design Case 2; C.3 Shear Proof Case 3. 
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The specification data of the reinforcement and cross-section geometry are defined in the input window 

“Data slab concrete” as shown in Fig.6.  For this example, identical orthogonal reinforcement at both faces is 

specified. The outer reinforcement courses go parallel to Xp, whereas the inner courses are parallel to Yp.  All 

reinforcement bar diameters are  = 10 mm; the concrete cover is c = 30 mm, the bars crossing in contact. 

These data are necessary from begin with to estimate the static heights of individual reinforcement courses. 

 
Fig.6  Concrete data input window – reinforcement and cross-section geometry 

The reinforcement courses pertaining to +Zp /–Zp are distinguished by the indices +/–.  The natural order of 

courses at a face is marked by indices 1, 2 – from the outermost to innermost course within the cross-section. 

In the following numerical analysis, the first reinforcement courses will be discussed with no loss of univer-

sality.  In Cases 1, 2, which deal with design points on the diagonal symmetry axis, the reinforcement 

amounts as1 and as2 are approximately in the ratio of the corresponding static heights [1].  

 

Fig.7  Design results: stat. required reinforcement as2- [mm²/m] – Direct values in element nodes 

(ULS) 
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Fig.8  Design results: stat. required reinforcement as2+ [mm²/m] – Direct values in element nodes 

(ULS) 

C.1  Design Case 1: Statically Required Reinforcement – Elliptic Tension 

As seen from Fig.2,3, in element 5, inner node 2 (coincident with the FE mesh node 2) both bending 

moments are positive: mx > my > 0, i.e. tension at the lower face –Zp.  The torsion moment mxy tends to zero; 

however, the theoretically exact zero value is “polluted” by the FEM approximation.  Thus, an elliptic state 

of stress with tension at face –Zp is to examine in this design point.  From Fig.2,3 and the Test Strategy 

protocol, the following Table 1 has been set up.  Its graphic representation is given by Fig.9. 

Table 1. Inner moments [kNm/m] (Basic/ Principal/ Design) in element 5, node 2 (Test Strategy line 1#) 

mx my mxy mI mII αI,II m1d m2d mcd 

39.3 39.3 -0.4 40.0 38.6 -45.0° 40.0 40.0 -1.4 

 
Fig.9  Graphic representation of Table 1 (elliptic inner moment transformation, face –Zp) 
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The generalized invariant relation (5) in [1] is satisfied: 

m1d + m2d + mcd = 40.0 + 40.0 – 1.4 = 78.60   ≡   mI + mII = 40.0 + 38.6 = 78.60   [kN/m]  (1) 

The design moments {m1d, m2d, mcd} may be, in analogy to mathematic terminology, considered as separated 

result values of the 2D design problem, which thus disintegrates into three individual pseudo 1D design 

cases. With the inner forces levels (the Plate design model enables exact distinguishing of reinforcement 

courses): 

zi = ζmean × hi (2) 

h1= h – c –  /2 = 0.250 – 0.030 – 0.010/2 = 0.215 [m],  h2 = h1 –   = 0.215 – 0.010 = 0.205 [m],  ζmean = 0.96514 [-] 

z1 = 0.96514 × 0.215 = 0.20751,  z2 = 0.96514 × 0.205 = 0.19785  [m] 

The required reinforcement amount is then calculated formally as in two mutually independent 1D members: 

asi,req = mid / ( fyd × zid) (3) 

as1-,req = m1d / ( fyd × z1d) = 0.040 / (500 / 1.15 × 0.20751) = 4.4310–4 [m²/m] = 443 [mm²/m] (not displayed here)  

as2-,req = m2d / ( fyd × z2d) = 0.040 / (500 / 1.15 × 0.19785) = 4.6510–4 [m²/m] = 465 [mm²/m](agreement with Fig.7) 

The virtual concrete strut, which function may be characterised as “stiffening of the reinforcement net 

against distortion in its plane” is checked as “compression concrete zone without compression 

reinforcement” [1]. The strut check is governed by the formula: 

ξstrut  < ξlim   [-] (4) 

where ξlim is the limit value of the relative bending zone height; ξstrut is the actual relative height of the 

bending zone under the impact of mcd. With the 1st default values of the reduction factor rfac = 0.80 (i.e. 80% 

of full design strength of concrete, weakened by parallel cracks, is applied) and the limit value of the relative 

bending zone height ξlim = 0.450 (Fig.10), the following relation is met:  

ξstrut = 0.012 < 0.450  

There is a substantial resistance reserve in this design point; (to be expected, since mcd → 0 (double symmetry)). 

 
Fig.10  Concrete Setup - limit value of the relative bending zone height and strength reduction factor  
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C.2  Design Case 2: Statically Required Reinforcement – Hyperbolic Stress 

As seen from Fig.2,3, in element 21, inner node 4 (coincident with the FE mesh node 21), the bending 

moments mx and my tend towards zero while the torsion moment attains an intensity level comparable with 

the bending moments in element 5. This is a typical hyperbolic state of stress, as the altering signs of the 

principal moments mI > 0 and mII < 0 demonstrate – see Table 2.  The graphic representation is given by 

Fig.11. 

Table 2. Inner moments [kNm/m] (Basic/ Principal/ Design) in element 21, node 4 (Test Strategy line 2#) 

mx my mxy mI mII αI,II m1d m2d mcd 

2.7 2.7 -33.1 35.9 -30.4 -45.0° 35.9 35.9 -66.2 

 

 

Fig.11  Graphic representation of Table 2 (hyperbolic inner moments transformation, face +Zp) 

The generalized invariant relation (5) [1] is satisfied: 

m1d + m2d + mcd = 35.9 + 35.9 – 66.2 = 5.5   ≡   mI + mII = 35.9 – 30.4 = 5.5  [kN/m] (5) 

The most distinguishing difference of the invariant relations (1) and (5) is that of the intensity level of the 

design moments mcd : in the elliptic stress case (1), it is a value tending to zero; in the hyperbolic stress case 

(5), it is a significant quantity, here absolutely about twice as high as the sum of absolute values of the 

principal moments. This is characteristic a phenomenon for the hyperbolic cases: the stiffening function of 

the concrete, the virtual strut, becomes the crucial factor of the designability. 

Analogously to the elliptic Case 1, the required reinforcement in both directions at face +Zp is calculated as 

follows: 

h1= 0.215 [m],  h2 = 0.205 [m],  ζmean = 0.96514 [-] 

z1 = 0.93936 × 0.215 = 0.20196,  z2 = 0. 93936 × 0.205 = 0.19257  [m] 

The required reinforcement amount is then calculated formally as in two mutually independent 1D members: 

as1+,req = m1d / ( fyd × z1d) = 0.0359 / (500 / 1.15 × 0. 20196) = 4.0810–4 [m²/m] = 408 [mm²/m](not displayed here)  

as2+,req = m2d / ( fyd × z2d) = 0.0359 / (500 / 1.15 × 0. 19257) = 4.2810–4 [m²/m] = 428 [mm²/m](agreement with Fig.8) 

The virtual concrete strut is checked by the relation (4): 

ξstrut = 0.204 < 0.450  

Thus, there is still a resistance reserve of the virtual strut in this hyperbolic state of stress.  

Hint: the procedure of checking the virtual strut bearing capacity is a very distinguishing feat of 

SEN/NEDIM, which hardly any competing software comprises. The topic of checking the stiffening function 

of concrete in bent continua has been dealt with in some detail in [2]. 
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C.3  Design Case 3: Shear Proof 

Some features of the SEN/NEDIM Shear Proof procedure will be demonstrated on element 1, inner node 1 

(coincident with the FE mesh node 1).  Fig.4 displays here the maximum value of vx.  As seen from Fig.2,3, 

the bending stress tends here towards zero, which is a plausible result.  From the Test Strategy line 3# 

document, the following relations can be established: 

vx = 51.0, vy = –0.2 [kN/m], β0 = –0.2 [°]   →   vEd = 51.0  [kN/m] 

The “theoretical” values are: vy = 0, β0 = 0.  Since there are no accidental load cases specified, the material 

partial security coefficients are γs = 1.15 and γc = 1.50, thus fyd = 434.8 and fcd = 13.33 [MPa]. The shear 

resistance without shear reinforcement according to §6.2.2 (6.2a) is estimated as 

vRd,c = 91.3 > vEd  [kN/m] 

Thus, no shear reinforcement is required in this design point, and nowhere in the model, since here the most 

critical design situation appears. 

C.4  Alternative Design Cases 1+2: Reinforcement Geometry (0°/60°/120°) and (–135°/45°) 

Numerical results and screen copies of this Paragraph were obtained by the project 

Plate_Benchmark_EN(1). 

To demonstrate the distinguishing features of the 2D design module SEN NEDIM, the use of a 3-course 

reinforcement net is presented and briefly discussed. In engineering practice, ~95% of design cases represent 

the elementary arrangement of orthogonal reinforcement with congruent nets at faces –Zp /+Zp, the outer 

course parallel to Xp, the inner course parallel to Yp – as if it were a “nature law”.  NEDIM offers, however, 

general reinforcement arrangements – combining different specifications of orthogonal, skew angular or 3-

course reinforcement, respectively, at both faces.  Here we will discuss some features of a “nonstandard 

design”, using the reinforcement nets (0°/60°/120°) at face –Zp and (–135°/45°) at face +Zp.  

(This Paragraph C.4 will be completed in Release 4 of this Benchmark document) 

D. Required Minimum Reinforcement 

Numerical results and screen copies of this Chapter were obtained by the project Plate_Benchmark_EN(2). 

In this Chapter, the effect of activated minimum tension reinforcement specification according to NEDIM 1st 

default input, as shown in Fig.12, is dealt with. As a fact, the user may modify the settings, but accepting the 

1st default, legal solution according to the Norm is obtained. 

 

Fig.12  Input dialogue window – max/min tension reinforcement set active 
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The choice of the “Automatic calculation of minimum tension reinforcement” ensures the consideration of 

the EN provisions to prevent so called brittle fracture, according to §9.2.1.1(1) (9.1N). The alternative to this 

option is the input of percentage which will be superposed in each point to required tension reinforcement; 

this is non-standard control under EN 1992-1-1:2004.  The control option “Maximum percentage in pressure 

bending zone” serves to limit the amount of required compression reinforcement to the given percentage 

related to the pressure bending zone force; the 1st default of 50% limits thus the steel force to 50% of the 

concrete force.  In this example, however, this option is without practical impact since there is no 

compression reinforcement required. 

From the relation §9.2.1.1(1) (9.1N) the following formula for 2D calculation of the minimum reinforcement 

against brittle fracture follows: 

ast,min = max (0.26 fctm / fyk , 0.0013) × d     [m²/m] (6) 

With d1 = 0.215 m, fctm = 2.20 and fyk = 500 NEDIM estimates 

as,min = max (0.00114, 0.0013) × 0.215 × 106
 = 279.5 [mm²/m] 

We find the value of 280 mm²/m in the display of the functions as2-,req+min and as2+,req+min in Fig.13 and 14. All 

values 280 in the reinforcement display (marked) signalize that the pure statically required tension reinforce-

ment is less than this minimum value. This can visually be checked in comparison with Fig.7,8. 

 

 

Fig.13  Reinforcement as2-,req+min [mm²/m] – Direct values in nodes 
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Fig.14  Reinforcement as2+,req+min [mm²/m] – direct values in element nodes 

E. SLS Design – Reinforcement Augmented to Limit Crack Widths 

Numerical results and screen copies of this Chapter were obtained by the project Plate_Benchmark_EN(2) 

(continued from Chapter D). 

In this Chapter, the effect of activated minimum tension reinforcement specification according to NEDIM’s 

1st default input, as shown in Fig.12, is dealt with. As a fact, the user may modify the settings, but accepting 

the default value, a legal solution according to the Norm stipulations will be obtained. 

The declared task of the Crack Proof (particularly of the 2D design) is checking the crack widths in all 

design points according the stipulations of EN 1992-1-1:2004, §7.3.4 “Calculation of crack widths” and 

augmenting the reinforcement delivered via the database from the ULS phase so as to meet the condition 

wcal ≤ wk (6) 

with wcal – the actual crack width calculated from the formula §7.3.4, (7.8).  As a fact, SEN/NEDIM seeks 

the value fulfilling the equality in (6) by a sophisticated (sub-linearly controlled) iteration process. The result 

is the reinforcement amount as2,ULS+SLS which meets the requirements of both ULS and SLS design phases: 

 as2,ULS+SLS ≥ as2,req+min ≥ as2,req (7) 

(compare with Fig.16,17 and Tab.3,4).  In the Crack Proof algorithm not only the bar diameters  but also 

the specified bar distances s (Fig.15) play a crucial role: they represent the user’s decision to use 

reinforcement bars of this diameter, spaced at maximum by the distance specified.  Thus, the final 

reinforcement amount as2,ULS+SLS respects this restriction as a kind of “overall minimum reinforcement”. In 

this example, the reinforcement amount corresponding to  = 10/s = 200 (Fig.6,15) → as,min,constr = 393 mm²/m 

will be encountered at several design points, both upper and lower reinforcement – as marked in Fig.16,17. 
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Fig.15  Concrete setup window – maximum allowable reinforcement bars distances 

 

 

 

Fig.16  Reinforcement as2-, ULS+SLS [mm²/m] – Direct values in nodes 
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Fig.17  Reinforcement as2+,ULS+SLS [mm²/m] – direct values in element nodes 

Following Tables 3,4 compare the reinforcement designed at the three design stages discussed above. Blue 

marks the stage Minimum and Red marks the stage Crack Proof – when the reinforcement amount obtained 

here is higher than in the previous design stage(s). Only reinforcement values as2± (direction 90°) presented in 

the following tables are shown above.  All of them can be checked by viewing the display data of the 

projects (0) to (2). 

Table 3. Comparison of the reinforcement stages in design points 5/2, 21/4 and 1/1 ~ Lower face 

Elem/Node 

Reinforcement at face -Zp ~ as1  – 

[mm²/m] 

Reinforcement at face -Zp ~ as2  – 

[mm²/m] 

as1-,req as1-,req+min as1-,ULS+SLS as2-,req as2-,req+min as2-,ULS+SLS 

5/2 443 443 443 465 465 519 

21/4 344 344 393 361 361 439 

1/1 28 280 393 0 0 0 

Table 4. Comparison of the reinforcement stages in design points 5/2, 21/4 and 1/1 ~ Upper face 

Elem/Node 

Reinforcement at face +Zp ~ as1+ 

[mm²/m] 

Reinforcement at face +Zp ~ as2 + 

[mm²/m] 

as1+,req as1+,req+min as1+,ULS+SLS as2+,req as2+,req+min as2+,ULS+SLS 

5/2 0 0 0 0 0 0 

21/4 408 408 408 428 428 486 

1/1 0 0 0 35 280 393 
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The examination of Tables 3,4 enables the following conclusions, which possess general validity: 

(1) Pronounced values of statically required reinforcement are typically “resistant” to augmentation by mini-

mum reinforcement or Crack Proof requirements; 

(2) Either the minimum reinforcement or Crack Proof requirements may yield higher reinforcement; the 

superposition result represents always the highest amount; 

(3) If the statically required reinforcement amount is zero, the application of the minimum reinforcement or 

Crack Proof requirements has no impact upon its augmenting; the SEN/NEDIM result value as,ULS+SLS re-

mains zero!  This may sometimes be found surprising if not irritating: it is, however, not the task of 

SCIA software to present non-existing results. However, the user is not obliged to apply zero 

reinforcement where he will use a nonzero reinforcement constructively. 

(4) FEM is an approximate (numerical) method of solving differential mechanical problems. The results 

(inner forces) are mean values on element and represent basically non-continuous functions. Thus, 

“unexplainable” reinforcement values, as compared with “theoretical” values of other (analytical) 

solutions or models, are hardly erroneous; they are true counterparts of the inner forces, which are used 

by NEDIM without any biasing “adaptations” [3].  The design point in element 1, node 1 is a typical 

example of these relations: “theoretically”, all 4 reinforcement values are zero, but this is never true in a 

FEM model. Thus, we have got as1+ = as2– = 0 (as expected), but as2+, as1– > 0 – due to the “numerical 

polution” of the FEM solution. 
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